
                                      
User Bulletin 
ABI PRISM® 7700 Sequence Detection System
July 6, 2000

SUBJECT: Sequence Detection System Software Version 1.7 Update (Revised)

Overview Version 1.7 of the Sequence Detection System (SDS) software is now available for 
download from the Applied Biosystems Web site. In addition to increased stability, the 
new release features several improvements over the previous version including:

� Improved algorithms

� Support for TaqMan® MGB Probes

� Ability to do programmed temperature ramps

� Enhanced SYBR® Green Analysis

� Updated Instrument Firmware

IMPORTANT Once an instrument has been upgraded to version 1.7, a service call is required 
to downgrade the SDS software to an earlier version. The upgrade introduces several changes 
to the instrument firmware that do not work with earlier versions of the SDS software.

IMPORTANT The SDS software version 1.7 upgrade is not validation compliant. Customers 
requiring validation compliance must continue to use SDS version 1.6.3 until the next validation 
compliant version is released toward the end of this calendar year.

Note Version 1.7 no longer supports the 7200 plate reader instrument, which is now 
discontinued.

In This User Bulletin This user bulletin contains information on the following topics:

Topic See Page

What You Need to Know About the Updatea

a. Before upgrading your ABI PRISM 7700 instrument, read the information in this section carefully to ensure 
that your system meets all of the minimum requirements.

2
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Bug Fixes 10
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What You Need to Know About the Update

Important
Considerations

Before Upgrading

IMPORTANT Before upgrading your ABI PRISM 7700 instrument, read the information in this 
section carefully to ensure that your system meets all of the minimum requirements.

The following list of bullet points discusses the important factors that may help you 
decide whether to upgrade your instrument to version 1.7 and the changes you can 
expect to see in the new version of the software.

� The SDS software version 1.7 upgrade is not validation compliant. Customers 
requiring validation compliance must continue to use SDS version 1.6.3 until the 
next validation compliant version is released toward the end of this calendar year.

� To upgrade your instrument to SDS version 1.7, it must first be running SDS 
version 1.6.3. The version 1.7 upgrade is not compatible with earlier versions of 
the SDS software.

� Once upgraded to version 1.7, you will not be able to downgrade the software to 
an earlier version without the assistance of an Applied Biosystems service 
engineer. The upgrade introduces several changes to the instrument firmware that 
do not work with earlier versions of the SDS software.

� After the installation, you must reconfigure your SDS software preferences. During 
the upgrade, the installation program discards the existing SDS Preferences file.

� In contrast to previous versions of the SDS software, when the “Not In Use” 
sample type acronym is applied to a well in SDS version 1.7, the function affects 
all dye layers. See “‘Not In Use’ Function” on page 10 for more information.

� Improvements to the multicomponent algorithm may produce differences in SYBR 
Green assay CT values generated using SDS version 1.7. See “Enhanced SYBR 
Green Assay Analysis” on page 9 for more information.

Version 1.7 System
Requirements

Installing version 1.7 of the SDS software to a computer running a Macintosh® 
Operating System version earlier than 7.6.1 may render the computer inoperable. The SDS 
software Version 1.7 upgrade does not support versions of the Macintosh OS earlier than 7.6.1. 

Your Macintosh computer must meet the minimum following hardware and software 
requirements to install version 1.7 of the Sequence Detection System software:

Macintosh Model 7200a,b

a. Macintosh 7200 computers must run OS 7.6.1 to upgrade to SDS 1.7. If another operating system is 
present, the version 1.7 upgrade may render the Macintosh inoperable. 

b. Macintosh 7200 computers running 1.7 should not be upgraded to OS 8.0 or later. The increased memory 
requirements of Macintosh OS 8.x may cause the SDS software to crash.

4400 G3 G4 

Macintosh OS Versions 7.6.1 7.6.1  8.5.1/8.6 9.0

Memory Configuration 32 MB 32 MB 64 MB 64 MB

Virtual Memory Configuration OFF

Storage Requirements 100 MB

CAUTION!
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How to Get the Update

Obtaining
the Software from

the Internet

The SDS software version 1.7 is available from the Applied Biosystems Web site 
(http://www.pebio.com/techsupp/swpps/7700sw.html). Before downloading the 
update, make sure that your computer meets or exceeds the minimum requirements 
specified on page 2. 

Note You must have Aladdin Stuffit Expander™ to install the SDS 1.7 software update. The 
latest version of Stuffit Expander is free and available on the Aladdin Systems, Inc. Web site 
(http://www.aladdinsys.com). 

Downloading the Software to a Macintosh

To obtain the update package, click the SDS 1.7 hyperlink from the Applied 
Biosystems Web site and your Macintosh will download the compressed SDS 1.7 .hqx 
file. To extract the installer, drag and drop the icon for the downloaded SDS 1.7 .hqx 
file onto the icon for the Aladdin Stuffit Expander program, and the Macintosh will 
extract the SDS v 1.7 Installer file. If the installation fails, download a later version of 
Stuffit Expander from the Aladdin Systems, Inc. Web site (http://www.aladdinsys.com) 
and re-attempt the installation.

Note If unable to find the compressed SDS 1.7 .hqx file once downloaded, you can locate it 
using the Find (z–F) command from the File menu. 

Downloading the Software to a Windows-Compatible Computer

If necessary, the SDS software version 1.7 update can be downloaded from the 
Applied Biosystems Web site to a Windows ® -compatible computer, then transferred 
to a Macintosh computer and extracted for use.

Upgrading During a
Service Visit

Applied Biosystems service personnel can upgrade your instrument software during a 
routine maintenance visit. Before requesting the upgrade, make sure that your 
computer meets the minimum requirements specified on page 2.

To obtain the update package:

Step Action

1 Click the SDS Software Version 1.7 hyperlink from the Applied Biosystems Web site.

The internet browser prompts you with options for downloading the software.

2 Follow the instructions for downloading the software.

The computer downloads the compressed SDS 1.7 .hqx file from the Web site.

3 Transfer the compressed SDS 1.7 .hqx file to the desktop of the Macintosh 
computer to which you wish to install the software.

Note If unable to find the compressed SDS 1.7 .hqx file once downloaded, you 
can locate it using the Find utility from the Start menu. 

4 Drag and drop the compressed SDS 1.7 .hqx file onto the Aladdin Stuffit 
Expander™ software icon.

Note If the installation fails, download a later version of Stuffit Expander from the 
Aladdin Systems, Inc. Web site (http://www.aladdinsys.com) and re-attempt the 
installation. 

The Stuffit Expander extracts the compressed SDS v 1.7 Installer file.
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Installing the Software

What Occurs During
the Installation

During the installation, the SDS v 1.7 Installer program will selectively replace and 
modify the program files for the existing version of the SDS software. The update is 
completely automated and does not require you to make any modifications to the 
existing Background Component or Pure Dye files. 

Performing the
Version 1.7 Update

After reading the topics discussed on the previous page and verifying that your system 
meets the minimum requirements for SDS version 1.7, follow the instructions below to 
install the software to your ABI PRISM 7700 instrument.

Step Action

1 Verify that your instrument is running the correct version of the SDS software.

a. Open the existing SDS software on your instrument.

b. From the  menu, select About Sequence Detector.

c. Check the version number. 

If the SDS version is less than 1.6.3, arrange for a Applied Biosystems service 
engineer to update your software before installing version 1.7.

2 If necessary, download the SDS v 1.7 Installer program to your desktop 
(see “Obtaining the Software from the Internet” on page 3).

3 Double-click the SDS v 1.7 Installer installer icon and follow the instructions given by 
the installer software. 

The software installs the SDS software version 1.7 to your computer, and prompts 
you to Continue or Quit the installation.

4 Click Quit.

5 Open SDS software version 1.7.

6 Reconfigure the SDS software preferences as follows: 

a. From the Edit menu, select Preferences. 

The Preferences dialog box appears.

b. Reconfigure the Preferences as needed, and click OK.

c. Open a document, and click Show Analysis. 

d. From the Analysis menu, select Options.

The Analysis Options dialog box appears.

e. Reconfigure the Analysis Options as needed, and click OK.

f. From the Instrument menu, scroll to the Diagnostics submenu, and select 
Advanced Options.

The Advanced Options dialog box appears.

g. Reconfigure the Advanced Options as needed, and click OK.

The software displays a warning message requesting you to quit and relaunch 
the application.

Note It is not necessary to quit and relaunch the SDS software at this time.
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New Features and Modifications

Feature Summary Version 1.7 of the SDS software features the following improvements and 
modifications:

Improved
Algorithms

Improved Allelic Discrimination 

The allelic discrimination algorithm is now more reliable. Under certain assay 
conditions, the allelic discrimination algorithm would generate unscored wells. The 
improved algorithm reduces the number of unscored wells and consequently reduces 
the number of samples that must be reanalyzed.

Enhanced Spectral Compensation 

SDS 1.7 features an enhanced version of the spectral compensation algorithm. The 
recommended usage is as follows:

� For all multi-reporter real-time and end-point runs (including Allelic 
Discrimination), spectral compensation should be activated for the post run 
analysis. Activating spectral compensation improves dye spectral resolution.

� For all single reporter real-time runs (including SYBR Green), spectral 
compensation is not required and should be deactivated for the post run analysis 
to ensure the most precise results. 

Feature See Page

Improved Algorithms 5

Support for TaqMan MGB Probes 6

Data Collection on Programmed Ramps 6

Enhanced SYBR Green Assay Analysis 9

To adjust the spectral compensation feature immediately after a real-time run:

Step Action

1 If not within the Analysis view, click Show Analysis.

2 From the Diagnostics submenu in the Instrument menu, select Advanced Options.

The Advanced Options dialog box opens.

3 Click the Use Spectral Compensation for Real Time checkbox within the 
Miscellaneous group box.

4 Click OK.

The software displays a warning message requesting you to quit and relaunch the 
application.

Note It is not necessary to quit and relaunch the SDS software at this time.

Click here to activate the spectral 
compensation feature
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Support for TaqMan
MGB Probes

Version 1.7 of the SDS software supports the non-fluorescent quenchers of TaqMan 
MGB Probes used for allelic discrimination assays. In previous versions of the 
software, TAMRA™ was hardcoded as the only quencher for allelic discrimination 
probes. With the introduction of non-fluorescent quenchers, the software was modified 
to permit the use of probes that employ other quenchers. See the Primer Express 
Version 1.5 and TaqMan MGB Probes User Bulletin (P/N 4317594) for more 
information on the design and use of TaqMan MGB Probes in allelic discrimination 
assays.

Note Real-time runs are not affected by this modification and were always able to support 
analysis of probes with non-fluorescent quenchers.

Data Collection on
Programmed Ramps

Note This feature was included in the SDS software version 1.7 to support the use of the 
ABI PRISM™ Dissociation Curve Analysis software, which will be available free-of-charge from 
the Applied Biosystems Web site.

SDS software version 1.7 supports data collection on programmed ramps (up to 
19:59 minutes). The ramping feature can be employed at any PCR stage by selecting 
the desired stage from the thermal cycler profile and clicking the “Set Ramp Time” 
button. Data collected using this feature can be exported as a multicomponent file and 
analyzed using the ABI PRISM™ Dissociation Curve Analysis software.

Guideline for Programming Temperature Ramps

Applied Biosystems recommends programming ramps so that they span the longest 
possible time (up to 19:59 minutes). Longer programmed ramps provide the greatest 
separation of the derivative peaks during the analysis, and therefore the maximum 
resolution for the run.

The following procedure demonstrates how to configure the recommended 
programmed ramp on the 7700 instrument for a SYBR Green assay.

To program the ABI PRISM 7700 instrument for a ramp: 

Step Action

1 Choose New Plate from the File menu.

The New Plate dialog box appears.

2 Configure the New Plate dialog box as follows:

a. Select the following options from the pop-up menus.

b. Click OK.

The software creates a plate document with the specified characteristics.

Pop-up Menu Choose…

Plate Type Single Reporter

Plate Format Standard Plate

Run Real Time
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3 Disable the quencher dye for the SYBR Green assay.

a. From the Sample Type Palette submenu in the Setup menu, select Sample Type 
Setup.

The Sample Type Setup dialog box appears. 

b. Click the Quencher checkbox to remove the check mark from the option. 

c. Click OK. 

4 Choose Thermal Cycler Conditions (cccc–T) from the Setup menu.

The Thermal Cycler Conditions dialog box appears.

5 Configure the Thermal Cycler Conditions profile with two holds for the maximum and 
minimum temperatures of the ramp.

6 Click or select the second stage of the ramp. 

The software will highlight the selected stage in red.

7 Click Set Ramp Time.

The Ramp Time dialog box appears.

To program the ABI PRISM 7700 instrument for a ramp: (continued)

Step Action

Maximum ramp 
temperature

Minimum ramp 
temperature
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8 Set the elapsed time for the ramp:

a. Click the arrow buttons on either side of the display to set the ramp time.

Note The total elapsed time for the ramp cannot exceed 19:59 minutes.

b. Click OK.

The software displays the elapsed time for the ramp in the diagonal line connecting 
the two stages.

9 Click Show Data Collection.

The Thermal Cycler Conditions dialog box displays the Data Collection options for 
the experiment.

10 Configure the Data Collection options as follows:

a. If absent, add a data collection icon to the ramp by clicking on the slope.

IMPORTANT Data collection must be turned on for all programmed ramps, 
otherwise the SDS software will not collect data during the ramp.

b. Click OK.

11 Configure the plate document with the sample and dye information.

12 Load the samples into the ABI PRISM 7700 Sequence Detection System.

13 Click Run to begin the ramp.

IMPORTANT Deactivate spectral compensation for the post-run analysis of 
real-time and dissociation curve runs using the SYBR Green dye. See page 5 for 
more information on the spectral compensation feature.

To program the ABI PRISM 7700 instrument for a ramp: (continued)

Step Action

Click here to set the minutes

Click here to set the seconds

Elapsed ramp time

Data collection icon
ge 8 of 16 Sequence Detection System Software Version 1.7 Update (Revised)



Enhanced SYBR
Green Assay

Analysis

IMPORTANT SDS version 1.7 requires that the SYBR Green entry in the Pure Dye Setup be 
abbreviated “SYBR”. The software will not operate properly if another abbreviation is used or if 
any of the letters in the entry are lowercase.

The improvements made to the multicomponent algorithm also increase the precision 
and reproducibility of SYBR assays. Consequently, CT values generated for a SYBR 
assay using version 1.7 may be slightly different than those generated with an earlier 
version of SDS software. The plots in Figures 1 and 2 illustrate the difference in 
analyzed SYBR Green data.

Figure 1 SDS Software Version 1.6.3 Analysis

Figure 2 SDS Software Version 1.7 Analysis
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Bug Fixes

“Save As” Errors In previous versions of the SDS software, data was occasionally lost when the 
“Save As” function was used before or after a run. This problem has been corrected in 
SDS version 1.7, so the function performs as expected.

“Not In Use”
Function

IMPORTANT If a well is set to “Not In Use” prior to a run, SDS 1.7 will not collect data for the 
well in any dye layer.

Unlike previous versions of the software, when the “Not In Use” sample type is applied 
to a well in SDS version 1.7, the software applies the label to the well in all dye layers, 
regardless of which dye layer the selection is made. The “Not In Use” function allows 
you to remove a well from analysis so that the software analyzes only wells that 
contain useful data. 

Outstanding Issues

Macintosh
Operating System

Incompatibility

Because of problems acknowledged by Apple regarding the Macintosh Operating 
System version 8.1, Applied Biosystems does not support Mac OS 8.1 for any model 
Macintosh computer.

Quantity Values
Reported for Wells

with CTs of 40

When a threshold has been adjusted for a real-time run, the SDS software fails to 
update the quantities for those wells that achieve CTs of 40 (no amplification) as a 
result of the adjustment. Upon analysis, the SDS software estimates an initial 
threshold setting for the run and presents the results in the Amplification Plot window. 
If the threshold is adjusted, the recalculation may cause some wells to reach CTs of 40 
(i.e., no amplification). Although the software should report the new quantities of the 
wells as zero, it does not reset the previous values for the wells.

This bug does not adversely affect the reporting of real data, however it does impact 
wells that should not have measurable amplification signal. Therefore, Applied 
Biosystems recommends that you disregard the reported quantity of any well with a 
CT of 40.
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Troubleshooting

Troubleshooting SDS version 1.7 

Observation Possible Cause Recommended Action

SYBR data analyzed in 1.7 varies 
from how it was analyzed in 1.6.3.

Improvements to the multicomponent 
algorithm produce differences in SYBR 
assay CT values generated using SDS 
version 1.7. See “Enhanced SYBR 
Green Assay Analysis” on page 9 for 
more information.

No corrective action is warranted.

After adjusting the threshold, the 
software displays a quantity of 
product for wells with a CT of 40 
(no amplification). 

This is a recognized bug in the SDS 
software. See “Quantity Values 
Reported for Wells with CTs of 40” on 
page 10 for a full explanation.

Disregard any quantity value reported 
for a well with a CT of 40. They are 
considered anomalous and invalid. 
The CT values reported for other wells 
are accurate.

The following error box appears 
when you attempt to begin a run.

� The instrument was inactive for an 
extended period of time.

� The lithium batteries in some older 
instruments have reached their life 
expectancies and do not permit the 
instruments to retain the new 
version of the instrument firmware.

a. Click Auto Download.

The software downloads the correct 
firmware from the Preferences folder.

b. Quit the SDS software. 

c. Restart the Macintosh computer 
and the ABI PRISM 7700 
Instrument. 

d. After the re-initialization is 
complete, run the SDS software.

e. Re-configure a plate document 
with the settings for your run.

f. Click Run.

The instrument begins the run.

To prevent this problem, do not 
deactivate your 7700 instrument for 
extended periods of time.

Wells selected as Not In Use are 
disabled in all dye layers instead of 
one as in previous versions of SDS.

The Not In Use function is a fixed 
feature of version 1.7. See page 10 for 
a full explanation.

No corrective action is warranted.

SDS application quits when you click 
on the Analysis menu.

The SDS program file is probably 
corrupt.

Delete the SDS software program file 
located in the SDS folder and reinstall 
the software from the original CD.

When printing an SDS dialog box, 
the buttons in the printout do not 
contain the correct text. Instead, they 
display letters in the boxes next to 
the wells.

Your Macintosh is running OS 8.0 or 
8.1 which are not compatible with SDS 
version 1.7.

Using the compatibility table on 
page 2, determine the correct 
operating system to use with your 
model Macintosh. Update your 
computer to a compliant version. 

Click here
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Manually Configuring the PCR Stage

� Data is absent in the amplification 
plot, but visible in the plate view. 

� The X-axis of the amplification 
plot displays a range of 
0–1 cycles. 

� Closing the dialog box may be 
impossible.

IMPORTANT Do not force quit 
(option+z+esc) the application.

� The plate does not contain 
amplification data.

� The auto-compute feature of the 
SDS software is unable to detect 
the PCR stage and extension step 
for your run.

To exit the analysis dialog box:

a. Enter “0” in the Use Threshold, 
Baseline Start, and Baseline Stop 
text boxes.

b. Click Update Calculations.

c. Click OK.

To correct the problem, manually 
assign the PCR stage for the SDS 
software analysis as shown in the 
procedure below. 

Troubleshooting SDS version 1.7 (continued)

Observation Possible Cause Recommended Action

To manually set the PCR stage and extension step in the Analysis Options:

Step Action

1 From the Analysis menu, select Options. 

The Analysis Options dialog box appears.

2 From the Extension Phase Data Extraction group box, click the Automatically 
compute PCR Stage checkbox to remove the check.

The software activates the User Defined options box.

3 Configure the manual settings for the PCR Stage and Extension Step:

a. Click the second radio button within the User Defined group box. 

b. From the Stage menu, select the PCR stage of your thermal profile.

c. From the Extension Step menu, select the extension step of your PCR stage.

Note The software will now analyze only the stage and step you assigned.

4 Click OK. 

5 From the Analysis menu, select Analyze.

Click here to disable 
the auto-compute feature
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Technical Support

Reaching Us on the
Web

Applied Biosystems Web site address is:

http://www.pebiosystems.com/techsupport

We strongly encourage you to visit our web site for answers to frequently asked 
questions, and to learn more about our products. You can also order technical 
documents and/or an index of available documents and have them faxed or e-mailed 
to you through our site (see the “Documents on Demand” section below).

Reaching Us by
E-Mail

Contact technical support by e-mail for help in the following product areas.

Documents on
Demand

Free 24-hour access to Applied Biosystems technical documents, including MSDSs, is 
available by fax or e-mail.

You can access Documents on Demand through the internet or by telephone:

For this product area Use this e-mail address

Chemiluminescence info@tropix.com

Genetic Analysis galab@pebio.com

LC/MS apisupport@sciex.com

PCR and Sequence Detection pcrlab@pebio.com

Protein Sequencing, Peptide and DNA Synthesis corelab@pebio.com

To order... Then...

through the 
internet

Use http://www.pebiosystems.com/techsupport

You can search for documents to order using keywords. 

Up to five documents can be faxed or e-mailed to you by title.

by phone from the 
United States or 
Canada

a. Call 1-800-487-6809 from a touch-tone phone. Have your fax 
number ready. 

b. Press 1 to order an index of available documents and have it faxed 
to you. Each document in the index has an ID number. (Use this as 
your order number in step “d” below.)

c. Call 1-800-487-6809 from a touch-tone phone a second time.

d. Press 2 to order up to five documents and have them faxed to you.

by phone from 
outside the United 
States and 
Canada

a. Dial your international access code, then 1-858-712-0317 from a 
touch-tone phone. 

Have your complete fax number and country code ready (011 
precedes the country code). 

b. Press 1 to order an index of available documents and have it faxed 
to you. Each document in the index has an ID number. (Use this as 
your order number in step “d” below.)

c. Call 1-858-712-0317 from a touch-tone phone a second time.

d. Press 2 to order up to five documents and have them faxed to you.
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Hours for Telephone
Technical Support

In the United States and Canada, technical support is available at the following times.

See the “Regional Offices Sales and Service” section below for how to contact local 
service representatives outside of the United States and Canada. 

Reaching Us by
Telephone or Fax in

North America

Call Technical Support at 1-800-831-6844, and select the appropriate option (below) 
for support on the product of your choice at any time during the call. (To open a 
service call for other support needs, or in case of an emergency, press 1 after dialing 
1-800-831-6844.)

Product Hours

Chemiluminescence 9:00 a.m. to 5:00 p.m. Eastern Time

LC/MS 9:00 a.m. to 5:00 p.m. Pacific Time

All Other Products 5:30 a.m. to 5:00 p.m. Pacific Time

For Support On This Product Dial 1-800-831-6844, and...

ABI PRISM® 3700 DNA Analyzer

BioInformatics (includes BioLIMS™, 
BioMerge™, and SQL GT™ applications)

DNA Synthesis

Fluorescent DNA Sequencing

Fluorescent Fragment Analysis 
(includes GeneScan® applications)

Integrated Thermal Cyclers

PCR and Sequence Detection

Peptide and Organic Synthesis

Protein Sequencing

Press FAX

8 650-638-5891

Press FAX

25 505-982-7690

Press FAX

21 650-638-5981

Press FAX

22 650-638-5891

Press FAX

23 650-638-5891

Press FAX

24 650-638-5891

Press FAX

5, or call

1-800-762-4001, 
and press 1 for 
PCR, or 2 for 
Sequence 
Detection 

240-453-4613

Press FAX

31 650-638-5981

Press FAX

32 650-638-5981
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Regional Offices
Sales and Service

If you are outside the United States and Canada, you should contact your local 
Applied Biosystems service representative.

Chemiluminescence

LC/MS

For Support On This Product Dial 1-800-831-6844, and...

Telephone FAX

1-800-542-2369 
(U.S. only), or

1-781-271-0045 
(Tropix)

781-275-8581 
(Tropix)

9:00 a.m. to
5:00 p.m. ET

Telephone FAX

1-800-952-4716 650-638-6223 

9:00 a.m. to
5:00 p.m. PT

The Americas

United States
Applied Biosystems
850 Lincoln Centre Drive
Foster City, California 94404

Tel: (650) 570-6667
(800) 345-5224

Fax: (650) 572-2743

Canada (Mississauga, Ontario)

Tel: (905) 821-8183
(800) 668-6913

Fax: (905) 821-8246

Latin America (Del.A. Obregon, Mexico)

Tel: (305) 670-5310
Fax: (305) 670-4349

Europe 

Austria (Wien)

Tel: 43 01 867 35750
Fax: 43 01 867 357511

Hungary (Budapest)

Tel: 36 1 270 8398
Fax:  36 1 370 8288

Benelux (Nieuwerkerk a/d IJssel, 
Netherlands)

Tel: 31(0) 180 392355
Fax: 31(0) 180 392359

Italy (Milano)

Tel: 39 (0)39 83891
Fax: 39 (0)39 8389492

Chekia Rep. (Praha)

Tel: 420 2 4143 0534
Fax: 420 2 4143 0535

Norway (Oslo)

Tel: 47 23 12 06 05
Fax: 47 23 12 05 75

Denmark (Allerød)

Tel: 45 45 58 60 00
Fax: 45 45 58 60 01

Poland (Warszawa)

Tel: 48 22 866 40 10
Fax: 48 22 866 40 20

Finland (Espoo)

Tel: 358 (0)9 251 24 250
Fax: 358 (0)9 251 24 243

Portugal (Lisboa)

Tel: 351 (0) 605 33 14
Fax: 351 (0) 605 33 15

France (Paris)

Tel: 33 (0)1 69 59 85 85
Fax: 33 (0)1 69 59 85 00

Russia (Moskva)

Tel: 70 095 935 8888
Fax: 70 095 564 8787
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Germany (Weiterstadt)

Tel: 49 (0) 6150/ 101 0
Fax: 49 (0) 6150/ 101 101

South Africa (Johannesburg)

Tel: 27 11 478 0411
Fax: 27 11 478 0349

Spain (Madrid)

Tel: 34 (0)91 806 1210
Fax: 34 (0)91 806 1206

United Kingdom (Warrington, Cheshire)

Tel: 44 (0)1925 825650
Fax: 44 (0)1925 282502

Sweden (Stockholm)

Tel: 46 (0)8 619 4400
Fax: 46 (0)8 619 4401

All Other European Countries, 
Middle East/West Asia, Africa 
(Langen, Germany)

Tel: 49 6103 708 301
Fax: 49 6103 708 310

Switzerland (Rotkreuz)

Tel: 41 (0)41 799 7777
Fax: 41 (0)41 790 0676

Japan

Japan (Hatchobori, Chuo-Ku, Tokyo)

Tel: 81 3 5566 6100

Fax: 81 3 5566 6501

Eastern Asia, China, Oceania

Australia (Scoresby, Victoria)

Tel: (03) 9730 8600/1 800 033 747
Fax: (03) 9730 8799

Malaysia (Kuala Lumpur)

Tel: 60 3 758 1118
Fax: 60 3 758 5688

China (Beijing)

Tel: 86 10 6238 1135 
Fax:

Singapore 

Tel: 65 896 2118
Fax: 65 896 2147

Hong Kong

Tel: 852 2590 0238
Fax: 852 2756 6968

Taiwan (Taipei Hsisn)

Tel: 886 22764 7199
Fax: 886 22698 3405

Korea (Seoul)

Tel: 822 593 6470
Fax: 822 593 6472

Thailand (Bangkok)

Tel: 66 2 319 7901
Fax: 66 2 319 9788

Europe (continued)
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